GEM Desktop Search Paths

between the application and any document types you specified in the
CONFIGURE APPLICATION dialog. Once you remove the configuration,
you can‘t start the application by opening one of its documents.
Furthermore, the GEM Desktop uses the generic set of icons to
represent the application and its documents. However, you can still
start the application by opening its icon.

To remove an application’s configuration, do the following:

1. Select the application’s icon.

2. Choose the Configure application command from the Options
Menu.

3. When the CONFIGURE APPLICATION dialog appears, click on the
Remove button.

SEARCH PATHS

A “search path” tells the GEM Desktop where to look for an application
when you open a document icon.

Unless you change it, the GEM Desktop goes through a standard
search path to find your applications. The standard search path
includes the following:

1. the folder or the root directory where the document icon you
opened is located

2. the GEMDESK folder on the disk where your GEM software is

located

3. the GEMAPPS folder on the disk where your GEM software is
located

4. the GEMSYS folder on the disk where your GEM software is
located

5. the root directory of the disk where your GEM software is located
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If you want the GEM Desktop to search other locations before
searching the GEMDESK, GEMAPPS, and GEMSYS folders, you can
insert a DOS Path command in your AUTOEXEC.BAT or GEM.BAT
document. Refer to your DOS operating system manuals for complete
instructions. '

DESK ACCESSORIES

Desk accessories are a special type of application. The GEM Desktop
comes equipped with clock, calculator, and print spooler desk
accessories. Other desk accessories are available from Digital
Research and other software development companies.

Desk accessories are unique because you can run them at the same
time you're running other GEM applications. For example, if you're
using GEM Draw and want to make some calculations for your picture,
you can use the calculator desk accessory without leaving the GEM
Draw application.

Start a Desk Accessory

You start every desk accessory the same way; you choose its name
from the DESKTOP Menu.

(To start a desk accessory from a GEM application, you make your
choice from a different menu, although the menu is always located in
the same place as the DESKTOP Menu. See the application’s manual
for details.)

Desk accessories appear in their own window on the GEM Desktop.
All desk accessory windows have a title bar and a close box.

If you click in a Desktop window while a desk accessory is on your
screen, the accessory’s title bar dims and the accessory goes behind
the Desktop windows. If you click on the visible part of the accessory,
it comes back in front of the windows and is active again.

It is possible for a desk accessory to be entirely covered by a Desktop
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window. If this happens, choose the accessory again from the
DESKTOP Menu to bring its window back on top of the Desktop
windows.

You can use the accessory’s title bar (while the accessory is active) to
drag it to a different location.

If you are using several desk accessories at the same time, only one
can be active. To put an accessory away, click on its close box.

Calculator

The GEM Desktop calculator resembles a standard calculator. Its
features and functions are explained in the text that follows the
illustration below:

Calculator

| ‘ 8] | <—— value Window

[ee] el [A-11]
(] (7] 8] [9] [/]
[e][a] (5106l [+]
L] (1] (2] [3] (-]
]l LI

You “press” the calculator’'s keys with the mouse pointer or keyboard
keys in the following ways:

O Click on any of the keys with the mouse button.

O Enter numbers using your keyboard’s standard number keys or the
numeric keypad.



Desk Accessories GEM Desktop

If typing on the numeric keypad moves the pointer rather than
entering numbers, press the Ctrl key to take the keypad out of its
cursor control function. If you still can’'t enter numbers, press the
Num Lock key.

® You can use the keyboard keys for all remaining functions. For
example, you can either click on the “+“ key or type the "“+”
character. Similarly, you can either click on the "M+” key or type
the characters “M” and “+".

The “+\-" key on the calculator changes the sign of the amount in
the value window to its complement. The keyboard equivalent for
this function is a backslash (\).

Memory Keys

You can use the memory keys (M+, M-, MR, and MC) to add, subtract,
recall, and clear values from a memory location in your calculator.

M+ Adds the amount in the value window to
memory. A small “M” appears at the left side
of the window to let you know you have
stored a result.

M- Works exactly like M+ except that it subtracts
the value from memory.

MR Recalls the present value from memory and
displays it in the value window.

MC Clears the value from memory. It does not
clear the value from the value window, so you
can use it in further calculations.

EC and C Keys

EC Clears your last entry from the value window.
You can continue your current calculations.

C Clears the value window and terminates your
current calculations.
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Clock

When you choose the Clock desk accessory, its window appears as
shown below left:

o 11:30 am
1/21/85 1/21/85

Mode indicator Mode indicator

To reset the time or date in the clock, you must change each
individual value (hour, minute, month, day, and year) separately. For
example, to reset the hour, begin by clicking on it. Then type two
digits to set the hour; that is, type “05” rather than just “5".

Click on “am” or “pm” to toggle between the two.
The clock has an alarm. To set the alarm, do the following:
1. Click on the “Mode Indicator”. It changes from a clock symbol to
a bell to let you know the clock is now in Alarm mode.

2. Set the time you want the alarm to sound by changing the hour,
minute, and “"am/pm” indicator as explained above for resetting
the time.

3. Click on the musical note at the far right side of the clock to turn
the alarm on. When the musical note is dimmed, the alarm is not
set to go off.

Print Spooler

The Print Spooler outputs documents to a printer. You'll find
instructions for using this desk accessory in Section 15.

End of Section 7






SECTION 8

Dialogs

Dialogs appear on your screen when the GEM Desktop needs to
communicate with you. The dialog conveys information you need or
asks you for information the GEM Desktop needs to complete your
instructions. Therefore, we categorize dialogs into two types:

® |nformation
® Data Entry

Before discussing the dialog types, we’ll describe “exit buttons”, a
component found in all dialogs.

EXIT BUTTONS

Every dialog has at least one “exit button”. In its simplest form, an
exit button provides a way to remove a dialog from your screen. The
dialog in the next illustration has one exit button labeled “OK”:

to configure this application. To free
up some space, you’ll have to remove
one of your currently configured
applications.

‘“; There is not enough space available
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After you read the dialog’s message, place the pointer on the exit
button and click. The dialog disappears from your screen and you can
resume work where you left off.

Many dialogs contain more than one exit button. Each button may
provide a different option as to what to do about the situation. The
next dialog illustrated has two exit buttons, “Retry” and "Cancel™

Drive A: is not responding. You must

use the right kind of disk, insert it

correctly, and close the door. If the

problen is with a hard disk, check the
disk’s connections.

Note that the "Retry” exit button has a heavier border than the "OK"
button. When an exit button has a heavy border like this, pressing
Enter is the same as clicking on that button.

INFORMATION DIALOGS

information dialogs convey information you requested or the GEM
Desktop feels you need. An example of an information dialog is the
one you see when you choose the Info/Rename command after
selecting a folder icon, as shown next:
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FOLDER INFORMATION

Folder name: PICTURES._
Created: 081-82-86 83:17 pn
Number of folders: 2
Number of items: _ 43
Bytes used: _ 157818

Many information dialogs contain only one exit button. After you read
the message, click on the exit button to remove the dialog and
continue your work.

Some information dialogs warn you of a problem that has occurred or
might occur if you continue what you are doing. Most dialogs of this
type contain one of the following icons:

This icon indicates you should make

'U’ note of the message inside the dialog
and then continue with your work as
normal.
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This icon means that if you continue
what you are doing, you could run into
a problem. These dialogs usually
contain a “Cancel” exit button so you
can abort the procedure if necessary.

This icon usually means you should
stop what you are doing because an
error has occurred.

(The foregoing are general descriptions of how these icons are used.
In practice, you might see them used differently.)

DATA ENTRY DIALOGS

Data entry dialogs appear when the GEM Desktop needs information
from you to complete an operation.

Most data entry dialogs contain areas where you type the required
information. These areas are called “data entry fields”. The dialog
might also ask you to enter the information by clicking on various
buttons. (These are not exit buttons, in most cases.) For example, i
you select a document icon and then choose the Info/Rename
command, you see the ITEM INFORMATION / RENAME dialog:
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ITEM INFORMATION / RENAME

Nane : BIGTRUCK.GEM‘
Size in bytes: 9676
Last modified: 01/17/86 09:38 an

Attributes: QLEEGIAUSIAY (Read-Only

| ok | [Cancel |

The ITEM INFORMATION / RENAME dialog is a combination information
and data entry type; it contains some information you can change and
some you can't.

The "Name” field is a data entry field, as indicated by the text cursor (a
vertical bar) at the end of the field. The field contains the name of the
icon you selected. Press the Backspace key to move the text cursor
back one space at a time and erase that character. Or, press the Esc
key to erase all characters in the field. You can then type whatever
characters you want in the field and they appear at the text cursor
location. (The table at the end of this section explains how to move
the text cursor and enter information in a data entry dialog.)

You can only enter information in the field where the text cursor is
located. To move the text cursor to a different field, place the pointer
anywhere in the field and click. If the text cursor doesn’t appear in the
field, you cannot enter information.

The next two fields in the dialog (“Size in bytes” and “Last modified”)
are not data entry fields. You can't change the information they
contain.
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Following the “Attributes” message are two buttons labeled
“Read/Write” and “Read/Only”. These are also data entry fields,
because they allow you to enter information about an icon. If you
click on the Read/Write button, it tells the GEM Desktop you will allow
the icon to be read from and written to the disk. If you click on the
Read/Only button, the GEM Desktop allows the icon to be read from
the disk, but not written back.

Buttons like Read/Write and Read/Only are similar to buttons on a car
radio because you can only select one at a time. When you select a
different one, the currently selected one “pops-off”. You’'ll see these
types of radio buttons in various other dialogs.

And, finally, at the bottom of the dialog are the exit buttons. If you
make a change in the dialog, click on the OK button (or press Enter)
and the GEM Desktop saves your changes. If you don't make any
changes, or if you make changes but don’t want them saved, click on
the Cancel button.

Key Effect
left-arrow™ Moves text cursor left one character without deleting.
right-arrow* Moves text cursor right one character without deleting.
down-arrow* Moves text cursor to next text field in which you can
or Tab enter information.
up-arrow” Moves text cursor to previous text field in which you
or Shift-Tab can enter information.
Delete* Deletes character to right of text cursor.
Backspace* Deletes character to left of text cursor.
Escape Erases all characters in text field.
* Effect is continous if key is held down.

End of Section 8
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SECTION 9

Menus and Commands

When you touch one of the titles in the menu bar (File, Options,
Arrange, or DESKTOP), a menu drops down showing commands you
can use to make things happen on the GEM Desktop. While the menu
is visible, drag the pointer through it to highlight each of the
commands. To choose a command, highlight the one you want and
click.

This section describes the commands that appear in each GEM
Desktop menu. Pictures of the menus follow with brief descriptions of
each command. Sometimes, a page reference shows you where to
find additional information about a command.

KEYBOARD SHORTCUTS

Some menu commands have a keyboard shortcut; typing a certain
sequence of keys is the same as using the pointer to display a menu
and choose that particular command.

If a command has a keyboard shortcut, you see the key sequence
indicated at the right side of the menu, opposite the command. For
example, opposite the Info/Rename command in the File Menu is a

diamond symbol followed by the letter “I”. The diamond symbol
represents your keyboard’'s Alt key, usually located at the left end of
the Space bar. Holding down the Alt key while typing the letter "I”, is

the same as displaying the File Menu and choosing the Info/Rename
command. You'l also find these keyboard shortcuts in your GEM
Desktop Keyboard Reference.



File Menu

GEM Desktop

FILE MENU

9-2

Opens the icon that is
currently selected (page 9-6).

Shows you information about the
currently selected icon. If an
application or document icon is

selected, you can rename it

Open
Info/Renane. ..

(page 9-6).

+]
Deletes all currently selected

Delete...
Format. ..

+D L ———e———"icons. Once deleted, you

cannot recover them.

To Output
Exit to DOS

\Formats your currently selected

floppy disk (page 9-8).

Starts the GEM QOutput
application (see Part Two).

Stops the GEM Desktop and
returns you to your

operating system.
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Options Menu

OPTIONS MENU

Install disk drive...

Configure application... *A
Set preferences...

Save desktop +y
Enter DOS commands +C

Adds or removes a disk drive
icon on the GEM Desktop
{(page 9-8).

Lets you specify how you want
an application to work with the
GEM Desktop (page 7-6).

Lets you specify how you want
some aspects of the GEM Desktop
to work {(page 9-9).

Saves your current preferences
and window arrangement for the
GEM Desktop (page 9-10).

Provides a way for you to enter
commands at your operating system
prompt. without stopping the GEM
Desktop. Enter "EXIT” at the
prompt to return to the GEM
Desktop.
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GEM Desktop

ARRANGE MENU

lﬂiﬁﬁiﬂﬁl

Show as text 3
Sort by name *N
b Sort by type P
Sort by size ¢Z
Sort by date 7T

9-4

This command “toggles” between
Show as text and Show as icons.
Use it to specify how you want
information to appear in your
windows (page 9-11).

Sorts the information in a
window by icon names
{(page 9-12).

Sorts the information in a
window by icon types
(page 9-13).

Sorts the information in a
window in descending order
according to the size of the

icon in bytes {page 9-13).

Sorts the information in a
window according to the date
the icon was created or last

changed (page 9-14).



GEM Desktop

DESKTOP Menu

DESKTOP MENU

Desktop info...

Calculator
Clock/Calendar
Desk RAccessory 3
Desk Accessory 4
Desk Accessory 5
Desk Accessory 6

e

Shows you information about the
GEM Desktop, such as its version
number, author names, and

copyright information.

Please read “Desk Accessories”
in Section 7 for complete
details on choosing and using

accessories.
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FILE MENU COMMANDS

Open Command

The results of the Open command depend on the type of icon that is
selected when you choose the command. Following are explanations
of what happens in each case:

Disk icon Displays the disk's contents in your window.
Folder icon Displays the folder’'s contents in the window.
Application icon Starts the application on your computer.
Document icon If you have configured the application that

created this document, the application starts
using the document you’'ve selected.

If you have not configured the application, you
see a dialog telling you the GEM Desktop
doesn’t know what you want to do with the
document.

info/Rename Command

When you choose this command, you see one of three dialogs,
depending on what type of icon is currently selected.

Disk icon

DISK INFORMATION

Drive identifier: C:
Disk label: HARDDISK
Number of folders: __ 43
Number of items: __685
Bytes used: _4644797
Bytes available: _3674112
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Folder icon

FOLDER INFORMATION

Folder name: PICTURES.
Created: 01-82-86 83:17 pn
Number of folders: __ 2
Number of itenms: M
Bytes used: _ 149244

Application or Document icon

ITEM INFORMATION / RENAME

Name: DRAW  .APP|
Size in bytes: __ 86736
Last nodified: 82/87/86 11:14 an

Attributes: QPEEUPHRUSIEY |Read-Only

| 0K ] [Cancel |
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Format Command
To format a floppy disk, do the following:
1. Insert the disk you want to format in one of your floppy disk
drives and close the drive door.

2. Click on the Desktop icon that represents the drive where you
inserted the disk you want to format.

3. Choose the Format command from the File Menu.
Note: Formatting a hard disk is something you should do only after

careful thought and planning. Therefore, the GEM Desktop does not
allow you to format a disk that has a hard disk icon.

OPTIONS MENU COMMANDS

Instalfl Disk Drive Command

You can use this command to make the disk icons shown on the GEM
Desktop exactly match your computer system. You can add a new
disk drive icon, change the icon’s label or drive identifier, or remove
an existing icon. Do the following:

1. Click on one of the existing disk drive icons on the GEM Desktop.

2. Choose the Install disk drive command from the Options Menu.
The INSTALL DISK DRIVE dialog appears.

3. If you are removing the disk drive icon, click on the Remove
button and you return to the GEM Desktop.

4. Type the letter you want to use to identify the disk drive.
Normally, floppy disk drives use the identifying letters “A” and “B”,
and hard disk drives use the letters “C” and "D".

5. You can also change the icon’'s label and specify its type as
Floppy Disk or Hard Disk using this dialog.
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6. When all of the information in the dialog is correct, click on the
Install button. You return to the GEM Desktop and the new disk
drive icon appears.

If you want to make your changes a permanent part of the GEM
Desktop, use the Save desktop command to save them. However,
read about the command later in this section before using it because
it also does other things.

Set Preferences Command

When you choose this command, you see the SET PREFERENCES
dialog:

SET PREFERENCES

Confirn deletes? IR
Confirn copies? [N
Double-click speed: HE (4]
Sound effects: [N
Tine fornat: [KENESTR
Date format: [NEIEIEN

[ ok ] | Cancel |

Click on the preferences you want as explained below:

Confirm deletes? “Yes” tells the GEM Desktop to always display
the DELETE FOLDERS / ITEMS dialog when you
do a delete operation. “No” tells the GEM
Desktop to bypass the dialog and begin the
delete operation immediately without waiting
for your confirmation.
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Confirm copies? Same as “Confirm deletes?” (above) except
that it pertains to copy operations.

Double-click speed Sets a relative speed for how quickly you
must double-click the mouse button.

Sound effects "On” causes the GEM Desktop to sound the
audible beeper on your system under certain
conditions. “Off” suppresses the audible
beeper in all cases.

Time format The “12 hour” preference displays time in an
am/pm format; for example, 3:00 am or 3:00
pm. The “24 hour” preference displays time in
a military or international format; for example,
0300 or 1500 hours.

Date format This preference is for internationalization of
dates. You can display the date in the format
MM/DD/YY (02/14/86) or YY/MM/DD
(86/02/14).

After setting the preferences the way you want, click on OK to return
to the GEM Desktop. Your preferences take effect immediately and
remain so until you quit the GEM Desktop. If you don’t make any
changes or do not want to save those you have made, click on the
Cancel button.

If you want to make your preferences a permanent part of the GEM
Desktop (that is, so they take effect every time you start the Desktop),
use the Save desktop command to save them. However, read the
following description of the command before using it because it also
does other things.

Save Desktop Command

This command tells the GEM Desktop to remember how you currently
have the Desktop set up to operate, and to always start the Desktop
as you now have it. You can use the command at any time and it
remembers the following Desktop characteristics:
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® the current size of the Desktop windows

® the object currently opened into each Desktop window; for
example, if one of the windows is displaying the contents of disk
drive A when you save the Desktop, it displays the contents of
that drive every time you start the GEM Desktop, assuming there
is a disk in the drive

® the way you currently have any applications configured (see
“Configure an Application” on page 7-6 for details)

® the current arrangement of disk drive icons on the GEM Desktop
(see the description of the Install disk drive command on page
9-8 for more information)

® your current preference settings (see the description of the Set
preferences command immediately preceeding this command
description)

ARRANGE MENU COMMANDS

Show as Text/Icons Command

You can display window contents in text form as well as in icon form.
The text display provides additional information about the icons in the
window. The following illustrations show the differences in the two
types of displays:
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CURPAGE BRAK 1446 0B4-01-86 07:25 an
MYLOGO  BAK 8634 ©01-24-86 01:32 pn
AD-MODEL GEM 680 02-07-86 85:47 an
AD-TRUCK GEM 10224 B82-87-86 06:35 am
BIGTRUCK GEM 9676 B1-17-86 089:38 an
CYURPAGE _GElt 1386 04-25-86 11:95 an

] C:\PICTURES\
¢ New Folder 00-00-88 12:00 an .
+ SALESHTG 04-17-86 03:37 pn

H] C:\PICTURES\ *
o O 8" -~
o & 0O 0O 2
Mew Folder SALESMTG CVRPRGE.BRK MYLOGO.BRK AD~MODEL.GEM AD-TRUCK.GEM BIGTRUCK.GEM CVRPAGE.GEM
E3
EASTREGN.GEM GRAPH.GEM GRAPHICD.GEM HOUSEZ2.GEM HOUSE3.GEM HOUSEPLN.GEM INVOICE.GEM MAP . GEM
.
|
MYLOGO.GEM ZOOM-2.GEM v

Sort by Name Command

This command arranges the icons in each window by their names.

] C:\GEMSYS\

)
)
)
=

) B

er RASSIGN.EGA ASSIGN.SYS DEFAULT.OPYT  GEMSEY-2.R GEMSETUP.APP GEMSETUP.DFN GEMSETUP.H

O 0O

GEMSETUP _RSC GEMSETUP.TXT GEMUDI.EXE HERMONPE _SYS IBMELBPE.SYS IBMHSSO? FNT IBMHSS10_FNT IBMHSS14_FNT

L] R

IBMHSS18 _ FNT IBMHSS36.FNT IBMHTRO?7.FNT IBMHTRIO.FNT IBMHTR{4.FNT IBMHTR{8.FNT IBMHTR3&.FNT IBMLSS10.FNT

New

F):[7

1
[J
)
[J

)
[
)
[
[
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Sort by Type Command

This command arranges the icons in each window by their types.

] C :\GEMAPPS\ .

[
i
[
[
il
2
=
55

New Folder BORDERS CHARTS FONTS PATTERNS DRAKW.APP ICONEDIT.RPP PAINT.APP

=
)
L
)
[
)
[
)

RCS2.AFP DESKTOP.DEF DESKTOP.DFN DESKTOP3.DFN GEMSETUP.DFN OUTPUT.DFN OUTPUTLO.DFN DESKTOP.H

[
)
[
)
[J
)
)
)

DESKTOP3.H GEMSETUP.H ICONRS . H QUTPUT.H OUTPUTLO.H DESKTOP.RSC DESKTOP3.RSC DRAW.RSC M

Sort by Size Command

This command arranges the icons in each window by their size in
bytes. The largest icons appear at the beginning of the list.

M C:\GEMSYS\ *
4 New Folder 00-00-80 12:00 an
OUTPUT  APP 60944 04-22-86 04:20 pn
HERMONP6 SYS 37376 B83-07-86 07:24 pn
IBMELBPS SYS 37376 03-07-86 88:07 pn
GEMSETUP APP 332808 B1-31-86 65:84 pn
GEMSETUP TXT 24423 83-B6-86 12:38 pn
GEMSETUP RSC 19172 04-28-86 B2:13 pn
QUTPUT __RSC 18790 _04-23-86  04:19 pn M
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Sort by Date Command

GEM Desktop

This command arranges the icons in each window according to the

date they were created or last modified.
dates appear at the beginning of the list.

lcons with the most recent

] C:\GEMSYSY .
+ New Folder 06-86-80 12:80 am
GUTPUT  INF 352 84-29-86 B67:23 am
GEMSETUP H 3213 04-28-86 ©2:13 pn
GEMSETUP DFN 1080 04-28-86 ©2:13 pn
GEMSETUP RSC 19172 04-28-86 82:13 pn
OUTPUTLO RSC 18366 84-23-86 04:28 pn
OUTPUT RSC 187290 04-23-86 04:10 pn
QUIPUT  SYM 12544 04-22-86 84:21 pn
End of Section 9



Part Three







SECTION 10

GEM Output Overview

GEM Output is a GEM application you use to reproduce your
documents on one of your output devices, such as your screen or
printer. The application is provided on one of your GEM Desktop
product disks under the name OUTPUT.APP and is represented by the
icon shown below:

OUTPUT.AFFP

When you run GEMPREP as explained in Section 2, it automatically
creates a folder named GEMSYS in the root directory of either your
hard disk or your GEM DESKTOP floppy disk. GEMPREP places GEM
Output in this folder. GEM Output is ready to use as soon as you
successfully complete GEMPREP.

OUTPUT PROCESSING MODES

You can run GEM Output in two different modes: Batch Mode or Auto
Display Mode.

Batch Mode

In this mode, you create a list of the documents you want GEM Output
to reproduce. Your list can contain from one to 36 document names.
GEM Output reproduces each document in your list on the device you
specify. Creating lists is explained in Section 12.
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Auto Display Mode

In Auto Display Mode, you can reproduce one or more documents
without placing their names in a list. This mode, therefore, is like a
“shortcut” way of using GEM Output because as soon as you start the
application, it begins outputting your documents to an output device.

When you use GEM Output in Auto Display Mode, you use it in slightly
different ways depending on where you start the application from, as
explained below:

GEM Desktop Select those documents vyou want to
reproduce from your Desktop windows before
you start GEM Output. (See “Preselect
Document Names” in Section 12 for limits that
apply to the number of documents you can
preselect.)

GEM Draw GEM Output automatically reproduces the
picture in your current drawing window. If
you have two drawing windows open, GEM
Output automatically reproduces both pictures.

Other GEM applications GEM Output automatically reproduces the
document in your active window, only.

Note: Before starting GEM Output from any GEM application while in
Auto Display Mode, be sure to save your document immediately before
starting GEM Output. This is necessary because GEM Output always
uses your most recently saved version of a document.

When you run GEM Output in Auto Display Mode, it reproduces your
document or documents on the device you currently have selected
and then returns you to the point from which you started GEM Qutput.

To enter Auto Display Mode, do the following:
1. Start GEM Output from the GEM Desktop as explained in Section
12. Do not select any documents before starting GEM Output.

2. When the GEM OQutput screen appears, display the Preferences
Menu and choose the Global command.
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3. When the GLOBAL PREFERENCES dialog appears, click on the
“Yes” button following “Auto display?”.

4. Click on one of the device icons on the right side of the screen
to indicate which device you want to use to reproduce your
document or documents.

5. Display the File Menu and choose the Quit command to return to
the GEM Desktop.

You'll find detailed information about how to complete the preceding
steps in following sections.

To turn Auto Display Mode off and return to Batch Mode, complete the
same steps you use to enter Auto Display Mode with this exception:
when the GLOBAL PREFERENCES dialog appears, click on the “No”
button following “Auto display?”.

Note: Unless otherwise noted, all instructions in Sections 11 through
14 are for running GEM Output in Batch Mode.

TYPES OF DOCUMENTS YOU CAN REPRODUCE

GEM Output is primarily designed for reproducing graphic documents.
However, you can also use it to reproduce non-graphic documents.
Some restrictions apply in each case, as explained in this section.

Graphic Document Reproduction

All GEM applications produce two versions of a document when you
save it on disk. However, you cannot use all of these document types
with GEM Output. The following table shows the document types you
can use with GEM Output and those you cannot.
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GEM Can be used with GEM Output?
Application Yes No
GEM Draw GEM BAK
GEM Graph GEM GRF
GEM Paint IMG / GEM*
GEM WordChart GEM WCH
GEM Wirite ouT DOC

(* - When reproducing GEM Paint documents with GEM Output, both
the IMG- and GEM-type documents must be in the same folder))

As the preceding table explains, you can create a list containing GEM-,
IMG-, and OUT-type documents, and GEM Output will successfully
process the documents in that listt However, if your list contains
BAK-, GRF-, DOC-, or WCH-type documents, your resuits with GEM
Output are unpredictable. In fact, outputting these document types
might cause your computer to “freeze-up”, and you will have to restart
or reboot it.

Non-Graphic Document Reproduction

Almost all DOS applications produce “ASCll-type” documents. (ASCIi
is an acronym for American Standard Code for Information
Interchange.) However, some documents are “pure ASCIl” whereas
others contain special formatting or control characters.

One example of this difference is the two types of documents you can
produce with WordStar. If you create a document in “non-document”
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mode, it is in pure ASCIl. If you create a document in “document”
mode, it contains special formatting characters that control how the
document looks on your monitor screen or other output device.

You can use GEM Output to reproduce documents that contain pure
ASCIl information. When your reproduce these documents on your
screen, GEM Output only displays one screen-full of information at a
time. Press any key to display the next and subsequent screens.
Press the Esc key to interrupt and terminate the display.

Reproducing a document that contains formatting or control characters
with GEM Output gives unpredictable results. This is because your
output device (screen, printer, etc.) might incorrectly interpret the
special characters. Therefore, you should not use GEM Output to
reproduce documents of this type. You should, instead, use the
reproduction facilities of the DOS application that created the
document.

To determine what type of documents a DOS application creates (pure
ASCII or otherwise), refer to the application’s manual.

End of Section 10
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SECTION 11

Getting Started

This section is divided into two parts. The first part explains how to
start GEM Output. The second part demonstrates a simple use of the
application to print documents.

START GEM OUTPUT

There are many different ways to start GEM Output. However, we'll
only describe the most useful ways in this section, which are the
following:

® The GEM Desktop File Menu contains a To Output command.
You can start GEM Output by choosing this command.

® You can start GEM Output from most GEM applications in the
same way. For example, if you're using GEM Paint, display the
File Menu and choose the To Output command. When you start
GEM Output from a GEM application, you have the option of
returning either to that application or to the GEM Desktop when
you leave GEM Output.

® Because GEM Output is a GEM application, you can start it by
opening one of its document icons. When you create and save a
list for GEM Output to use, you save it as a LIS-type document.
For example, if you create a list and save it as DEMOL.LIS, you'll
see it represented on the GEM Desktop by the icon shown below.
If you open DEMO.LIS, GEM Output starts automatically using the
documents in DEMO.LIS.

DEMO.LIS
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DEMONSTRATION

The following demonstration is not intended to be a tutorial because
there are too many variables to make a step—by-step tutorial practical.
Its primary purposes are to demonstrate how easy GEM Output is to
use and to explain the basic steps required to reproduce vyour
documents.

Step 1: Select Documents to Reproduce

Assume you've used GEM Draw to create two pictures named
BIGTRUCK.GEM and LITTLCAR.GEM and you now want to reproduce
these pictures on your printer.

While the GEM Desktop is on your screen, select the BIGTRUCK.GEM
and LITTLCAR.GEM icons either by dragging or Shift-clicking.

Step 2: Start GEM Output

Display the GEM Desktop File Menu and choose the To Output
command. GEM Output starts and your screen looks like the one
shown next:



GEM Desktop Demonstration

Menu Titles Menu Bar

~—

OUTPUT

File Preferences

untitled

C:\PICTURES\BIGTRUCK .GEM
C:\PICTURES\LITTLCAR.GEM

~ Start Icon

Pelete
fame

Output List Box Device icons

Let’s take a moment to examine some of the components on the GEM
Output screen. (We'll describe the other components in later sections.)

At the top of the screen is the menu bar containing the menu titles
“File”, "Preferences”, and "OUTPUT”. The menus work the same way as
on the GEM Desktop. The only command we’ll use in this
demonstration is Quit (from the File Menu), so we’'ll defer any
discussion of the other commands until later sections.

On the left side of the screen is the output list box. Notice that it
already contains the names of the documents we selected on the
Desktop: BIGTRUCK.GEM and LITTLCAR.GEM. The output list is ready
to use.

On the right side of the screen are four icons representing the output
devices you can use with GEM Output. The icons represent, from top
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to bottom, a printer, screen, plotter, and camera. Note that the printer
device icon is highlighted to indicate that it is the device GEM Output
will use unless you instruct it to use a different one.

Step 3: Start Output to a Device

To start printing the two pictures in the output list, click on the “Start”
icon or simultaneously press the Alt and S keys. The dialog below
appears indicating which document GEM Output is processing. After
printing both documents, the dialog disappears from your screen.

Itens processed: 1 of 2
Current item: BIGTRUCK.GEM

Copies made: 1

Press to stop at end of current page.

Step 4: Return to GEM Desktop

Display the File Menu and choose the Quit command to return to the
GEM Desktop.

You now know the basic steps to use GEM Output. You’'ll learn about
other features and other ways to use GEM Output when you read the
following sections.

End of Section 11



SECTION 12

Output Lists

You create output lists that tell GEM Output which documents you
want to reproduce. You can save lists and revise them either
temporarily or permanently.

When you start GEM Output, you see the following output list box on
your screen:

% untitled 7|+
1 A
Start 2| Title Bar Full Box/ ]
]
q
9 Slider
Add 6
Nane 7 )
8 Tool Kit Scroll
Delete ] Arrows
Nane 19
11 Scroll Bar =9
Duplicate 12
Nane 13
14
15 Size Box
16
12 \
18 v
< 1AL

The output list box is similar to a GEM Desktop window. It contains a
Title Bar, Full Box, Scroll Bar, Slider, and Scroll Arrows. It also
contains a Size Box and Tool Kit icons.
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SIZE BOX

You can use the Size Box to change the dimensions of the output list
box. This is useful in the following situations:

® the document names in your output list extend beyond the right
edge of the output list box

® you want to make room on the screen for a desk accessory
window

® a3 desk accessory window disappears behind the output list box
and you want to reactivate the accessory

Place the pointer on the Size Box and drag in any direction. When you
drag, you see a shadowy outline that previews the dimensions of the
output list box. When the shadowy outline is the size and shape you
want the output list box to be, release the mouse button.

TOOL KIT ICONS

The Tool Kit contains the following icons:

® Start icon

® Add Name icon

® Delete Name icon

® Duplicate Name icon

Explanations of and instructions for using these icons appear later in
this section.
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